
AYUDA DE WINQSB PARA EL MÓDULO DE
CADENAS DE MARKOV

About MKP

This program, MarKov Process (MKP), solves and analyzes markov processes. Specific capabilities include:

Solve steady state probabilities and first passage times

Perform step by step Markov process

Perform time dependent performance analysis and display the graphical result

Analyze total cost or return

Enter problem in spreadsheet format and check probability eligibility

Markov Process
A system exists in different states (or conditions). Over the time, the system will move from one state to
another state.  Markov process is usually used to characterize these movements or transitions.  To describe
and analyze a Markov process, we define the following terminologies:

State: a particular condition of the system, i = 1, 2, ..., n.
State Probability s(i): probability of the system in state i
Transition Probability p(i,j): probability of the system moving from state i to state j
S(t): set of all s(i) at time t, Ss(i) = 1
P: matrix to include all p(i,j), where i,j = 1, 2, ...,n

Given the system at time t with state probabilities S(t), then at time t+1, the system will be expressed by

S(t+1) = S(t) P

and at time t+2, the system will be expressed by

S(t+2) = S(t) P P = S(t) P²

and at time t+3, the system will be expressed by

S(t+2) = S(t) P P P = S(t) P³

and so on.

If the state probabilities do not change from period to period, the system is called in steady state.  Not every
system has a steady state.  If the system does reach steady state, the steady state probabilities, let say S,  have
the following property

S = S P (1)

Equation (1) in fact is consisted of n simultaneous equations with n state probability variables. To obtain the
steady state probabilities, replace any one equation in (1) with Ss(i) = 1 and solve the new n simultaneous
equations.



Expected Cost or Return
If each state of the system involves a possible cost or return, say c(i), then at time t, the expected cost or return
for the system is expressed by

TC = Ss(i) c(i)

where s(i) is the probability of state i at time t.

First Passage Time, Recurrence Time
The average length of time for the system going from state i to state j is called the first passage time.  The firs
passage time from state i to state i, i.e., leaving state i and returning to state i,  is called the recurrence time of
state i.

MKP Windows and Commands
The following lists the commands in the toolbars.

New Problem Load Problem

Save As Save Problem As

Print Problem Print

Exit/close Cut

Copy Paste

Number Format Font Selection

Left-align Center

Right-align Row Height

Column Width

Solve Steady State Markov Process Steps

Time Parametric Analysis Result Menu

Chart/graph Calculator

Clock Help



MKP Initial Window
The menus for the MKP initial window after the program is loaded are shown below.
File Menu

New Problem

Load Problem

Exit This command quits the program.

Help Menu

Problem Specification Window
To specify n MKP problem, here is the procedure:

Step 1. Enter the problem title, which will be part of the heading for the later windows.

Step 2. Enter the number of states for the problem.  This defines the scope of the Markov process.

Step 3. If the specification is complete, press the OK button for data entry.  Otherwise, press the
Cancel button.  The Help button is for this help message.

Markov Process Step Window
To perform the Markov process for the problem, here are the steps.
Specify the initial state probabilities and enter the number of time periods from now (i.e., initial), then press
the OK button.  The resulted state probabilities will be shown in the right column.  You may press the Steady
State button to obtain the steady state result. After the problem is solved, What If Analysis for Stagecoach
problem allows you to specify where your are and the program will give the best route to the destination.

Step 1. Specify the initial state probabilities, if they are not entered already.

Step 2. Enter the number of time periods from now (i.e., initial), which represents the time of
interest.

Step 3. Press the OK button to show the result on the right column.  The result will show the state
probabilities for that time period.  The expected cost or return, if any, will also be
calculated.

Step 4. Press the Print button to print the result.  Otherwise, press the Cancel button to leave the
process.  The Help button is for this help message.  Two other buttons are also useful: Next
Period for the next period result, Steady State for the steady state result.



Time Parametric Analysis Window
The parametric analysis solves and displays the result of total cost/return, individual state probability, or
individual state cost/return, against a specified range of time periods.  To perform the analysis, here are the
steps:

Step 1. Select an item from the list for the analysis.

Step 2. Enter the range of time periods of interest including the starting and ending time periods,
and the step of time period for the analysis.

Step 3. Press the OK button to show the result in table.  After the result table is shown, you can
then choose to display the graphic analysis from the Result menu.

Step 4. Press the Cancel button to leave the analysis.  The Help button is for this help message.

Results Menu

Show Steady State
This command shows the steady state solution of the problem.

Show First Passage Time
This command shows the first passage times for the problem.  It includes all possible connections of states.

Show Time Parametric Analysis - Table
This command shows the table result of the time parametric analysis.

Show Time Parametric Analysis - Graph
This command shows the graphic result of the time parametric analysis.

Utilities Menu

Calculator
This command shows the Windows system calculator.  You may specify the calculator in scientific or
standard view.

Clock
This command shows the Windows system clock.  You may specify the clock in analog or digital view.

Graph/Chart
This command allows you to design graphical charts.  It includes:

Area an area chart
Bar - 2D a two-dimensional bar chart
Bar - 2D - Stacked a two-dimensional stacked bar chart
Bar - 3D a three-dimensional bar chart
Bar - 3D - Stacked a three-dimensional stacked bar chart
Column - 2D a two-dimensional column chart
Column - 2D -Stacked a two-dimensional stacked column chart
Column - 3D a three-dimensional column chart
Column - 3D - Stacked a three-dimensional stacked column chart
Line a connected line chart
Pie - 2D a two-dimensional pie chart
Pie - 2D - % a two-dimensional pie chart with % shown



Pie - 3D a three-dimensional pie chart
Pie - 3D - % a three-dimensional pie chart with % shown
Scatter a scatter chart

See also Chart/Graph Commands.

Window Menu
Use the following commands to show the open windows in different arrangements.  This menu also displays a
list of the captions of the open windows and displays a check mark next to the one that has the focus.

Cascade
This command cascades all windows for the current problem.

Tile
This command tiles all windows horizontally for the current problem.

Arrange Icons
This command arranges all windows if they are minimized to icons.

Output File Menu
This menu includes the following commands:

Print
This command prints the current spreadsheet or graph to the default printer.  When printing a graph, the
program uses the best quality to print the graph.  Before printing a spreadsheet, choose an appropriate font
and size by using the command Print Font.

Quick Print Window
This command prints the current window to the default printer.  By using this command, the program only
prints the part shown on the window and the printing quality may not be the best.  However, it usually takes
less time to print.

Save As
This command starts a file save dialog for assigning a bitmap file name and directory for saving a graph or
chart, or assigning a text file name and directory for saving a spreadsheet.  The saved bitmap file can be
opened by any bitmap handling application such as Paintbrush, and the text file can be opened by the
spreadsheet application such as Microsoft Excel or wordprocessor such as Microsoft Word.

Copy to Clipboard
This command copies the bitmap of a graph/chart or the text of a spreadsheet to the clipboard.  You may paste
the bitmap to any other application which accepts bitmap data, or paste the text to any spreadsheet application
or wordprocessor.

Print Font

Print Setup

Exit



Graph/Chart Gallery Menu

Area
This command produces an area chart.

Bar - 2D
This command produces a two-dimensional bar chart.

Bar - 2D - Stacked
This command produces a two-dimensional stacked bar chart.

Bar - 3D
This command produces a three-dimensional bar chart.

Bar - 3D - Stacked
This command produces a three-dimensional stacked bar chart.

Column - 2D
This command produces a two-dimensional stacked column chart.

Column - 2D - Stacked
This command produces a two-dimensional stacked column chart.

Column - 3D
This command produces a three-dimensional stacked column chart.

Column - 3D - Stacked
This command produces a three-dimensional stacked column chart.

Line
This command produces a connected line chart.

Pie - 2D
This command produces a two-dimensional pie chart.

Pie - 2D - %
This command produces a two-dimensional pie chart with % shown.

Pie - 3D
This command produces a three-dimensional pie chart.

Pie - 3D - %
This command produces a three-dimensional pie chart with % shown.

Scatter
This command produces a scatter chart.

Graph/Chart Data Menu

Number of Sets
This command allows you to change the number of data sets for the chart.

Number of Points
This command allows you to change the number of data points per data sets for the chart.



Graph/Chart Data
This command initiates a spreadsheet for modifying the data point values for the chart.

Graph/Chart Title
This command allows you to change the title of the chart.

Left Title
This command allows you to change the left title of the chart.

Bottom Title
This command allows you to change the bottom title of the chart.

Label (Point) Text
This command allows you to change the label text of each data point of the chart.

Legend (Set) Text
This command allows you to change the legend text of each data set of the chart.

New Problem
This command starts a problem.  MKP brings up a form to specify the problem.  After the problem is
specified, you then can enter the problem data.  See Problem Specification Window for detail.

If there is an unsaved problem in editing when you select the New Problem command, MKP asks if you want
to save the problem.

Load Problem
This command starts a file open dialog to load a problem stored previously.  The dialog allows you to either
select a particular data file in a particular directory, or enter a complete data file specification including path
name.  MKP automatically displays the loaded problem.

Exit
This command closes the current window.  If the current window is the data entry window and the problem
has not been saved, MKP prompts you to quit any way or cancel the Exit command.  If you choose to cancel
the Exit command, you can then choose the Save Problem or Save Problem As command to save the problem.

Save Problem
This command saves any changes of the current problem to the current data file name.  If there is no current
data file name, MKP automatically starts a file save dialog for specifying a file name and directory.

Save Problem As
This command starts a file save dialog for assigning a file name and directory.  If the data file name is
successfully specified, the problem will be saved.

Print Problem
This command prints the current problem.  The problem will be printed in the same format as the data entry.
The discrete distribution, if any, will be printed following the data entry spreadsheet.  Use the Print Font
command to specify an appropriate font for the printing.  In general, a TrueType font such as Times New
Roman will produce a good result.

Print Font
This command starts a font dialog for selecting a print font.  You can select the available font for the printer
you connect.  The default font name is Times New Roman, a TrueType font, if available.  You can also assign



the properties of font size, bold, italic, and underline.  Note that MKP assumes that you have set up the default
printer through Windows Print Manager.

Print Setup
This command starts a print setup dialog for selecting the target printer, print orientation, and so on.

Cut
This command copies the portion of the editing area you select to the Clipboard and clears the selected area.
You must select an area you want to cut then use the Cut command.  To select an area from the current
window, see Select Area.

Copy
This command copies the portion of the editing area you select to the Clipboard.  The editing area is not
affected.  You must select an area you want to copy then use the Copy command.  To select an area from the
current window, see Select Area.

Paste
This command pastes the contents of the Clipboard to the selected area.  You must select an area you want to
paste then use the Paste command.  To select an area from the current window, see Select Area.

When pasting the data in the Clipboard into the selected area, only the selected area is affected.  If there are
more columns or rows in the selected area, the remaining columns or rows are set to empty.   If there are more
columns or rows in the Clipboard, the unused portion is ignored.

Clear
This command clears the selected area.  The affected data is not copied to the Clipboard.  You must select an
area you want to clear then use the Clear command.  To select an area from the current window, see Select
Area.

Undo
This command reverses any changes from the action you cut, paste, or clear from the selected area.  This
command only affects the current action of the current selected area.  After you select another area, the action
on the previous selected area can not be reversed.

Problem Name
This command allows you to change the problem name.

State Names
This command starts a form to change the state names of the current problem.  The state name can include
any character.  The default state names are State1, State2, ..., Staten.  Short and meaningful node names are
recommended.

Add a State
This command starts a dialog to add a new state to the current stagecoach problem.  You may add the new
state to the first column, last column, or a specified location.  The inserted state has a default name which can
be modified by the command State Names.

Delete a State
This command starts a dialog to delete a state from the current problem.  You may select a particular state to
delete.  The deleted state and its associated row/column or connections will disappear.



Number
This command selects the numeric format for the current spreadsheet.  The predefined options include:
    

Code Sample
Default Standard for output, General Number for data entry

    General Number As entered
    Standard 12,345.68
   Currency $12,345.68
    Fixed 12345.68
   Scientific 1.23E+04
    0.00 12345.68
   0.0000 12345.6789
    #,### 12,346
    #,##0 12,346 0 for zero
   #,##0.00 12,345.68 0.00 for zero
   #,##0.0000 12345.6789 0.0000 for zero
    $#,##0;($#,##0) $12,346 ($12,346)  for -12345.6789
  $#,##0.00;($#,##0.00) $12,345.68 ($12,345.68) for -12345.6789

Besides the predefined options, you may define the numeric format using the characters # or 0 (digit
placeholder), $ (dollar sign), "." (decimal placeholder), "," (thousand separator), E or e (scientific format), and
% (percentage placeholder).

Font
This command selects the font for the current spreadsheet.  You can also specify the font size, font color, font
style (bold and italic), and font effect (strikethrough and underline).  After changing the font name or font size
for the current spreadsheet, you may need to use the commands Row Height and Column Width to fit the new
font.

Alignment
This command aligns the data to the left, center, or right of the data cell.  You may specify that the alignment
is applied to:

All columns
First row
First column
Selected columns

MKP does not allow the alignment for a single cell or a few cells only.  It has to be one of the above options.
To select columns from the current window, see Select Area.

Align-left
This command aligns the data of the selected area (first row or columns) to the left of the data cell.

Align-center
This command aligns the data of the selected area (first row or columns) to the center of the data cell.

Align-right
This command aligns the data of the selected area (first row or columns) to the right of the data cell.

Row Height
This command assigns row heights to the current spreadsheet.  You may click or drag the scroll bar to
increase or decrease the row height, click the default row height, or let the program find the best fit for each
row.  You may specify that the row height is applied to:

All rows



Selected rows
First row only

MKP does not allow you to change the row height for a single cell or a few cells only.  It has to be one of the
above options.  To select rows from the current window, see Select Area.

If the option Best Fit is chosen, MKP will find the best row height for each of the specified rows based on the
font name and font size of the current window.  This will usually shrink the spreadsheet.  However, each row
may have a different height.

Note that you can also change the row height directly in the spreadsheet by placing the mouse on the line
between two cells of the first (leftmost) column and dragging the mouse to enlarge or shrink the row height.

Column Width
This command assigns the column width to the current spreadsheet.  You may click or drag the scroll bar to
increase or decrease the column width, click the default column width, or let the program find the best fit for
each column.  You may specify that the column width is applied to:

All columns
Selected columns
First column only

MKP does not allow to change the column width for a single cell or a few cells only.  It has to be one of the
above options.  To select an area from the current window, see Select Area.

If the option Best Fit is chosen, MKP will find the best column width for each of the specified columns based
on the font name and font size of the current window.  This will usually shrink the spreadsheet.  However,
each column may have a different width.

Note that you can also change the column width directly in the spreadsheet by placing the mouse on the line
between two cells of the first () row and dragging the mouse to enlarge or shrink the column width.

Select Area
To select an area from a spreadsheet, use one of the following steps:

(1).  Select a column: Click the  cell of the column.

(2).  Select consecutive columns: While holding the Shift key, click the  cell of the leftmost column you
want and then click the  cell of the rightmost column you want.  Then release the Shift key.

(3).  Select a row: Click the first (leftmost) cell of the row.

(4).  Select consecutive rows: While holding the Shift key, click the first (leftmost) cell of the most row
you want and then click the first (leftmost) cell of the bottommost row you want.  Then release the
Shift key.

(5).  Select a rectangular area: Click and hold the -left cell of the area and drag the mouse to the bottom-
right cell of the area.  Then release the mouse.  The selected area should be highlighted after the
action.

Solve Steady State
This command solves the steady state probabilities, if it exists, for the problem.

Markov Process Step
This command performs the Markov process step by step.  See Markov Process Step Window for detail.

Time Parametric Analysis



This command performs the analysis of total cost/return, individual state probability, or individual state
cost/return, against a specified range of time periods.  See Time Parametric Analysis Window for detail.

How To Enter a Problem
To enter an MKP problem, here is the general procedure:

1. Select the command New Problem or icon  to specify the problem.  Select the type of problem,
enter the problem name and the number of states.  See Problem Specification for explanation.

2. After the problem specification is done, the program will bring up the appropriate entry form in
spreadsheet format.  Here are some hints for what to enter:

(i). Enter the transition probabilities from a state to another state.  An empty entry represents no
connection between two states.  Enter the initial state probabilities, if known, in the next to the
last row.  Enter the state cost or return, if known, in the last row..

(ii). Use Tab or arrow keys to navigate in the spreadsheet.

(iii). You may click or double click a data cell to select it.  Double clicking the light blue entry area
above the spreadsheet will high-light the data entry.

(iv). Click the vertical or horizontal scroll bar, if it is shown, to scroll the spreadsheet.

4. (Optional) Use the commands from Edit Menu to change the problem name, state names, and to add or
delete states.

5. (Optional) Use the commands from Format Menu to change the numeric format, font, color, alignment,
row heights, and column widths.

6. (Optional, but important) After the problem is entered, choose the command Save Problem As to save
the problem.

How To Solve Steady State
To solve the steady states for the MKP problem, here are the general steps:

1. Enter the problem by the procedure How To Enter a Problem.  For a good practice, you may want to
save the problem by choosing the command Save Problem As before solving it.

2. Select the command Solve Steady State or Markov Process Step to solve the problem.

3. After the problem is solved, choose the commands from the Results Menu to display the appropriate
results.

How To Perform Markov Process
To perform Markov process step by step for the MKP problem, here are the general steps:

1. Enter the problem by the procedure How To Enter a Problem.  For a good practice, you may want to
save the problem by choosing the command Save Problem As before solving it.

2. Select the command Markov Process Step to bring up a form for the markov process.

3. Use the procedure of Markov Process Step Window to perform the step by step process.

How To Perform Time Parametric Analysis
MKP allows you perform the analysis of total cost/return, individual state probability, or individual state



cost/return, against a specified range of time periods.  To perform the analysis, here are the general steps:

1. Select the command Time Parametric Analysis.  The program will bring up a form to let you specify the
analysis.

2. Use the procedure of Time Parametric Analysis Window to perform the analysis.

How To Create a Graph/Chart

Create a Graph/Chart From A Spreadsheet Data

1. Select an area of data from the current spreadsheet.  See Select Area for how to select a data area.

2. Select the command Chart/Graph.  The program creates a 3D column chart for the selected data.

3. Using the Gallery Menu, you can change to different types of charts.

4. Using the Data Menu, you can change to titles and data for the chart.

Create a Graph/Chart From Other Data

1. Select the command Chart/Graph.  The program creates a 3D column chart with random data.

2.  Using the Gallery Menu, you can change to different types of charts.

3. Using the Data Menu, you can change to titles and data for the chart.

How To Import Data From Spreadsheet Applications
If you decide to enter a MKP problem with a spreadsheet application such as Microsoft Excel, use the
following steps:

1. Enter the problem with the following sequence.  Here are the entries for each cell on the spreadsheet:
(Note that cells are separated by "," and required texts are in "")

(i). Row 1:  "MKP", Problem name, number of states.

(ii). Row 2 and below:  rows and columns are the same as the spread form data entry.

From\to State1 State2 State3 .... Staten
State1 x x x ... x
State2 x x x ... x
State3 x x x ... x
... ... ... ... ... x
Staten x x x ... x

Initial Probabilityx x x ... x
State Cost/Return x x x ... x

2. Save the spreadsheet in a file with the text format.

3. The saved data file then can be retrieved by MKP.

How To Export Data To Other Applications
You may export the MKP problem data to other applications.  The following two methods can achieve the
task.



Through Clipboard
1. Click the left- cell of the MKP problem (which selects the whole problem).

2. Choose the command Copy or its icon to copy the whole problem to the Clipboard.

3.  Switch to the target application and use its Paste command to paste the problem to the target application.

Through File
1. Choose the command Save Problem As or its icon to save the problem to a file.

2. Switch to the target application and open the saved data file with the text format.


